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About SolarWinds 
SolarWinds, Inc develops and markets an array of network management, monitoring, and 
discovery tools to meet the diverse requirements of today’s network management and consulting 
professionals. SolarWinds products continue to set benchmarks for quality and performance and 
have positioned the company as the leader in network management and discovery technology. 
The SolarWinds customer base includes over 45 percent of the Fortune 500 and customers from 
over 90 countries. Our global business partner distributor network exceeds 100 distributors and 
resellers. 

Contacting SolarWinds 
You can contact SolarWinds in a number of ways, including the following: 

Team Contact Information 

Sales 1.866.530.8100 
www.solarwinds.com  

Technical Support www.solarwinds.com/support  
User Forums www.thwack.com 

 

Conventions 
The documentation uses consistent conventions to help you identify items throughout the printed 
and online library. 

Convention Specifying 

Bold Window items, including buttons and fields. 

Italics Book and CD titles, variable names, new terms 

Fixed font File and directory names, commands and code 
examples, text typed by you 

Straight brackets, as 
in [value] Optional command parameters 

Curly braces, as in 
{value} Required command parameters 

Logical OR, as in 
value1|value2 

Exclusive command parameters where only one of the 
options can be specified 

 

http://www.solarwinds.net/
http://www.solarwinds.net/support
http://www.thwack.com/
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SolarWinds VoIP Monitor Documentation Library 
The following documents are included in the VoIP Monitor documentation library: 

Document Purpose 
VoIP Monitor 
Administrator Guide 

Provides detailed setup, configuration, and conceptual 
information. 

Page Help Provides help for every window in the VoIP Monitor user 
interface 

Release Notes Provides late-breaking information, known issues, and updates. 
The latest Release Notes can be found at www.solarwinds.com.  

 
The following documents supplement the VoIP Monitor documentation library with information 
about Orion Network Performance Monitor: 

Document Purpose 
Orion Network 
Performance Monitor 
Administrator Guide 

Provides detailed setup, configuration, and conceptual 
information. 

Page Help Provides help for every window in the Orion Network 
Performance Monitor user interface 

Release Notes 
Provides late-breaking information, known issues, and 
updates. The latest Release Notes can be found at 
www.solarwinds.com.  

 
 
 
 
 
 
 
 
 
 
 

http://www.solarwinds.net/
http://www.solarwinds.net/
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Chapter 1 

Introduction 

SolarWinds Orion Voice over IP Monitor (VoIP Monitor) offers an easy-to-use, 
scalable VoIP network monitoring solution that integrates seamlessly into the 
Orion Network Performance Monitor Web Console. 

Why Install VoIP Monitor 
Voice over IP (VoIP) technology offers a cost-effective and efficient response to 
the telephony needs of enterprises of all sizes. As a VoIP network manager, you 
face more than the simple question of whether your network is up or down. You 
need to know specific quality of service measures for your network, and you 
need to know them both historically and in realtime. VoIP Monitor gives you the 
tools you require to quickly determine and track quality of service on your 
network over time. 

Orion VoIP Monitor leverages the proven functionality of Orion Network 
Performance Monitor (Orion NPM), adding a number of VoIP-specific data 
collection and presentation tools that enable VoIP-specific network monitoring 
and realtime status reporting. Because it is a module of Orion NPM, VoIP Monitor 
maintains the function of Orion NPM while allowing you to narrow your network 
management and monitoring focus to the VoIP-specific devices of your wider 
network. 

What VoIP Monitor Does 
VoIP Monitor provides a full-featured solution that gives you the ability to monitor 
and report the status of your VoIP network over time with performance statistics 
available in realtime. VoIP Monitor offers the following features to help you 
manage your entire VoIP network. 

Quality of Service (QoS) Monitoring with Cisco IP SLA Operations 

VoIP Monitor uses Cisco IP Service Level Agreements (IP SLAs) to measure 
VoIP network performance. Specifically, IP SLA operations provide 
immediate insight into VoIP network Quality of Service (QoS), including 
packet loss, latency, jitter, and mean opinion score (MOS) metrics. VoIP 
Monitor collects IP SLA data and then presents it in the easy-to-use Orion 
Web Console environment. With VoIP Monitor and IP SLA operations you 
know at a glance exactly how well your VoIP network is and has been 
performing. For more information about Cisco IP SLA operations, see 
www.cisco.com/go/ipsla. 



Administrator Guide  SolarWinds Orion VoIP Monitor  
 

 
2  Introduction  

Custom Alerts and Actions 

Leveraging the Orion Advanced Alert Manager, VoIP Monitor allows you to 
create custom alerts for your VoIP network in the same way you create 
custom alerts and actions in Orion Network Performance Monitor. 
Specifically, VoIP Monitor allows you to configure VoIP-related alerts with a 
variety of corresponding actions to notify you of VoIP events on your 
Orion-managed network. These VoIP alerts are filtered from existing Orion 
alerts and presented separately, within VoIP Monitor. For more information 
about using Advanced Alerts in VoIP Monitor, see “Using Advanced Alerts 
and Actions” on page 24. 

Custom Reporting 

With Orion Report Writer, VoIP Monitor provides realtime and historical 
statistics reporting for the VoIP-specific devices in your network. When you 
install VoIP Monitor, several predefined reports become available within 
Orion Report Writer. In addition, with the use of custom properties, you can 
also generate custom reports to specifically communicate the historical 
condition of your VoIP network. For more information about data reporting in 
VoIP Monitor, see “Creating VoIP Monitor Reports” on page 24. 

Call Manager Monitoring 

Call manager devices are scalable call-processing solutions for managing 
IP-based telecommunications networks. These devices provide VoIP 
networks with the same features and functionality of more traditional 
telephony. VoIP Monitor uses the SNMP and ICMP monitoring technology at 
the core of Orion Network Performance Monitor to interact with call 
managers. As a result, you are able to persistently track call manager 
performance. With the addition of VoIP Monitor, you immediately know the 
status of your VoIP network and all of its components at any time. Upon 
installation, VoIP Monitor allows you to monitor Cisco CallManager and 
CallManager Express devices. You can also define custom MIB pollers to 
monitor call managers from other manufacturers. For more information about 
custom MIB pollers, see “Creating Custom MIB Pollers” in the SolarWinds 
Orion Network Performance Monitor Administrator Guide. For more 
information about Cisco CallManager and CallManager Express devices, 
search for “CallManager” at www.cisco.com. For more information about 
monitoring Cisco CallManager devices with VoIP Monitor, see “Adding Cisco 
CallManager Devices to VoIP Monitor” on page 14. For more information 
about monitoring other call manager devices with VoIP Monitor, see “Adding 
Call Manager Devices from Other Manufacturers” on page 15. 

How VoIP Monitor Works 
Orion VoIP Monitor builds upon the proven technology of Orion Network 
Performance Monitor (Orion NPM) to give you monitoring, alerting, and reporting 
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abilities for your VoIP network. After installation and initial configuration, VoIP 
Monitor deploys Cisco IP Service Level Agreements (IP SLAs) to generate 
simulated VoIP traffic between devices on your network, in accordance with the 
jitter codec that you specify. Cisco IP SLAs provide realtime and historical 
performance statistics that VoIP Monitor presents in the readily customizable 
Orion Web Console. 

Note: VoIP Monitor uses simulated traffic, instead of real VoIP traffic, to ensure 
that performance data is continuously received so you can know the state of your 
network at any time, regardless of whether the network is actually being used to 
complete a call.  
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Chapter 2 

Getting Started with Orion VoIP Monitor 

Orion VoIP Monitor uses the same intuitive installer and configuration wizard 
interfaces that Orion Network Performance Monitor employs. Though it is an 
enterprise-class monitoring solution, VoIP Monitor does not require any 
additional resources beyond those required for the underlying implementation of 
Orion Network Performance Monitor. 

Installation Requirements 
The server that you use to host VoIP Monitor must also support an installation of 
Orion Network Performance Monitor. The following requirements are based on a 
minimum installation of VoIP Monitor with SQL Server on a separate database 
server. 

Note: To optimize database scalability, your SQL Server installation should be 
maintained on a server other than the one on which you are hosting Orion 
Network Performance Monitor and VoIP Monitor. 

Hardware/Software Requirements (for Orion server unless stated otherwise) 
Environment VoIP Monitor sites are limited to locations where there is an existing, 

Cisco IP SLA compatible router to serve as a simulation node. Cisco 
IP SLA compatible routers include 2600, 3700, and 7200 Series. For 
more information, see www.cisco.com/go/fn and select “IP SLAs – 
UDP Based VoIP Operation”. 

CPU 3GHz or faster 
RAM 2GB or more 

Hard Drive Space 5GB or more 

Operating System Windows 2003 Server SP1 and higher, including R2 (32-bit & 64-bit) 
with IIS installed 

.NET Framework Version 3.0 or later 
Orion Network 
Performance Monitor 

Version 8.5 or later 

SQL Server SQL Server 2000 SP4 and SQL Server 2005 (Express, Standard, or 
Enterprise) on a separate database server with 4-8GB of memory 
and at least 20GB of available hard drive space. 

Web Browser Internet Explorer version 6 and later 
Mozilla Firefox 2.0 

 

For more information about system requirements for Orion Network Performance 
Monitor, see “Requirements” in the SolarWinds Orion Network Performance 
Monitor Administrator Guide. 
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VoIP Monitor Licensing 
Orion VoIP Monitor is licensed in accordance with the underlying Orion NPM 
licensing. VoIP Monitor licenses are currently available at each level for which 
Orion NPM is presently licensed. For example, VoIP Monitor license VL100 
mirrors Orion NPM license SL100 to give you the ability to monitor up to 100 
VoIP resources, and VoIP Monitor license VLX (Enterprise) mirrors Orion 
Network Performance Monitor license SLX, giving you the ability to monitor an 
unlimited number of VoIP resources. For more information about Orion Network 
Performance Monitor licensing, see “Licensing Orion Network Performance 
Monitor” in the SolarWinds Orion Network Performance Monitor Administrator 
Guide. 

Installing VoIP Monitor 
Orion VoIP Monitor employs an intuitive wizard to guide your installation. The 
following procedure will complete your installation of Orion VoIP Monitor. 

Notes: 

• For most Orion VoIP Monitor installations, the Configuration Wizard 
automatically maintains the configuration settings that you entered for your 
initial Orion Network Performance Monitor installation. 

• If you are installing a web-only version of Orion VoIP Monitor on a remote 
Orion Network Performance Monitor server, please contact SolarWinds 
support at www.solarwinds.com for licensing instructions specific to your 
installation. 

To install Orion VoIP Monitor: 

1. Log on to the Orion NPM server you will use to monitor your VoIP network. 

Note: Orion VoIP Monitor requires an installation of Orion NPM version 8.5 
or later. 

2. If you downloaded the product from the SolarWinds website, navigate to 
your download location and launch the executable. 

3. If you received physical media, browse to the executable file, and then 
launch the executable. 

4. Read the welcome message, and then click Next to continue. 

5. Select I accept the terms of the license agreement, and then click Next. 

6. If you are ready to install Orion VoIP Monitor, click Install. 

7. When the wizard has completed installation, click Finish. 

http://www.solarwinds.com/
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8. If you are installing Orion VoIP Monitor on an additional poller that is 
not your primary Orion Network Performance Monitor poller, click 
Cancel on the Install Software License Key window. 

9. If this is a new installation of Orion VoIP Monitor, provide the appropriate 
information on the Install Software License Key window, and then click 
Continue. 

Note: You need your customer ID and password to install the key. For more 
information about Software License Keys, see “Software License Key” on 
page 29. 

10. Click Continue when the license is successfully installed. 

11. If the Configuration Wizard does not start automatically, click Start > 
SolarWinds Orion > Configuration Wizard. 

12. If this is a new installation of Orion VoIP Monitor, check Database, 
Website, and Services, and then click Next. 

13. If you are only updating or modifying specific components of your VoIP 
Monitor installation, check Database, Website, or Services, as 
appropriate, and then click Next. 

14. If you have chosen to modify Database Settings, complete the following 
steps: 

a. Specify the SQL Server that hosts the database in which you want to 
store VoIP data and the appropriate credentials, if necessary, to log on to 
this server, and then click Next. 

b. If you are creating a new database, select Create a new database, 
type a name in the New Database field, and then click Next. 

c. If you are using an existing database, select Use an existing 
database, select or type a name in the Existing Database field, and 
then click Next. 

d. If you are prompted to stop polling engines, click OK to stop the 
polling engines. 

Note: You must stop all polling engines to prevent the corruption of your 
collected data. 

e. If you want to create a new SQL account, select Create a new 
account, enter a New Account and Password, confirm the password, 
and then click Next. 

f. If you already have a SQL account, select Use an existing account, 
enter or select an Existing Account, enter the Password, and then click 
Next. 
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15. If you have chosen to modify Website Settings, complete the following 
steps: 

a. Specify the IP Address of the web server that you are using for your 
Orion NPM Web Console installation. 

b. Specify the TCP Port through which you access the Orion Web Console. 

Notes: 

• If you specify any port other than 80, you must specify that port in the 
URL that is used to access the web console. For example, if you 
specify an IP address of 192.168.0.3 and a port of 8080, your URL 
is http://192.168.0.3:8080. 

• Web browsers may report an error or security warning if the port that 
is designated for access to the web console is already assigned to 
another application. 

c. Click Browse to select the Website Root Directory in which you want to 
install the web console files or enter the appropriate path, and then click 
Next. 

d. If you are prompted to use an existing website, click Yes. 

16. If you have chosen to modify Services Settings, confirm that all services 
that you want to install are checked in the Service Settings window, and then 
click Next. 

Note: If you are installing Orion VoIP Monitor on an additional poller that is 
not your primary Orion Network Performance Monitor poller, confirm that 
SolarWinds VoIP Monitor Service is cleared. 

17. Review the configuration summary. 

18. If the configuration settings are correct, click Next. 

19. If you need to change any of the configuration settings, click Back and 
make the appropriate corrections. 

20. When the Configuration Wizard completes, click OK in the dialog, and then 
click Close in the Configuration Wizard. 

Understanding Quality of Service and IP SLAs 
IP Service Level Agreements (IP SLAs) are a diagnostic method developed by 
Cisco that generates and analyzes traffic between Cisco IOS devices on a VoIP 
network. By using VoIP Monitor to implement IP SLA operations between VoIP 
network devices, you can acquire realtime and historical statistics that give you 
accurate Quality of Service (QoS) measures for your network. VoIP Monitor 
builds on the proven monitoring capabilities of Orion Network Performance 
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Monitor and presents performance metrics generated with Cisco IP SLA 
operations over designated call paths on your VoIP network. 

Latency 
Latency, also known as delay or lag, is a measure of the time, in milliseconds, it 
takes to complete a transfer of information, either roundtrip or one-way, between 
two network devices. With respect to VoIP, latency is a measure of the difference 
in time between when one caller speaks and when the other caller hears what 
the first has said. Excessive network latency can cause both noticeable gaps and 
a loss of synchronization in transmitted conversations, particularly when VoIP is 
used with other types of data, as in a videoconference. If these gaps become 
large enough, callers may find that they will inadvertently interrupt each other 
while conversing. 

IP SLA operations measure latency by sequentially applying four different 
timestamps to a single test packet, as follows. 

1. Timestamp T1 is applied to a test packet as it leaves the source router. 

2. Timestamp T2 is applied as the test packet arrives at the target router. 

3. Timestamp T3 is applied as the test packet leaves the target router to return 
to the source. 

4. Timestamp T4 is applied when the test packet returns to the source. 

IP SLA operations then provide four separate measures of latency by computing 
differences among the four timestamps, as follows. 

Latency Measure Calculation 
Round Trip Time T4 – T1 

Source-to-Target Latency T2 – T1 

Target Processing Latency T3 – T2 
Target-to-Source Latency T4 – T3 

 

Note: Latency is computed for both Source-to-Target and Target-to-Source 
directions to account for asynchronous network behavior, providing a more 
detailed picture of overall network latency.  

Jitter 
Jitter is a measure, in milliseconds, of the variability of network latency that 
results in a loss of synchronization over time. Jitter is experienced as distracting 
noise, clicks, and pops. To ensure acceptable quality of service, network jitter 
should be located, isolated, and addressed. VoIP Monitor allows you to identify 
areas of your network that may be experiencing synchronization difficulties, 
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enabling you to take the necessary action to ensure maximum QoS on your VoIP 
network. 

VoIP Monitor requires that you select a jitter codec to properly configure IP SLAs 
for your VoIP network. Each codec dictates how jitter is computed by specifying 
that IP SLA operations send  a number of packets (n), each with a specific 
size (s), at a set interval (i) between packets, at a determined frequency (f), as 
shown in the following table.  

Codec 
IP SLA 
Operation 
Frequency (f) 

Default 
Number of 
Packets (n) 

Default 
Packet 
Size (s) 

Default Interval 
between 
Packets (i) 

G.711a 1000 160 + 12 
RTP bytes 20 ms 

G.711u 1000 160 + 12 
RTP bytes 20 ms 

G.729a 

Set on the VoIP 
Settings page 
as the Network 
test interval 

1000 20 + 12 
RTP bytes 20 ms 

 

The IP SLA Operation Frequency (f) for all codecs may be changed directly 
from the VoIP Monitor Settings page. On the VoIP Monitor Settings page, the 
Network test interval field corresponds to the IP SLA Operation Frequency 
value in the previous table. For more information about VoIP Monitor Settings, 
see “VoIP Monitor Settings Configuration” on page 18. 

Note: Based on the Cisco IP SLA operations used by VoIP Monitor, jitter codecs 
G.711a and G.711u can achieve peak MOS of 4.34. On the same basis, jitter 
codec G.729a can achieve a peak MOS of 4.06. 

Packet Loss 
Packet Loss is a quantitative measure of information loss over a given network 
connection. Though packet loss is inevitable in any network environment, the 
goal is always to identify where packets are lost in transmission so you can act to 
minimize information loss and maintain high QoS for your VoIP services. 
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Mean Opinion Score (MOS) 
MOS is an industry standard measure of call quality expressed on a scale of 
increasing perceived quality, from 1 to 5. VoIP Monitor reports MOS as computed 
by a standard International Telecommunications Union (ITU) algorithm involving 
the codec for your VoIP network and values of latency, jitter, packet loss, and 
MOS advantage factor. Jitter, latency, and packet loss are variable quantities that 
are measured by VoIP Monitor in realtime. Generally, MOS reflects call quality as 
shown in the following table. 

Call Quality MOS 
Very Satisfied 4.3-5.0 

Satisfied 4.0-4.3 
Some Users Satisfied 3.6-4.0 

Many Users Dissatisfied 3.1-3.6 

Nearly All Users Dissatisfied 2.6-3.1 
Not Recommended 1.0-2.6 

 

Both the MOS advantage factor and the codec algorithm are selected for your 
specific network on the VoIP Monitor Settings page. The following table provides 
some guidance as to how the advantage factor is determined for your 
application. 

Communication System Type Examples Maximum Advantage Factor Value 
Conventional wired network 0 

Wireless network within a building 5 

Outdoor wireless network (cellular phones) 10 
Remote communications by satellite 20 

 

For more information MOS calculations, see ITU-T Recommendation G.107. For 
more information about codec algorithms, see “Jitter” on page 9. For more 
information about VoIP Monitor Settings, see “VoIP Monitor Settings 
Configuration” on page 18. 

Setting VoIP Traffic Precedence 
VoIP Monitor allows you to set the precedence, or packet priority, of VoIP traffic. 
Setting precedence levels for VoIP traffic enables you to better ensure high 
quality of service on your VoIP Network. VoIP Monitor employs a decimal Type of 
Service value that is specified on the VoIP Monitor Settings page. For more 
information about VoIP Monitor settings, see “VoIP Monitor Settings” on page 16. 
The Type of Service value used by VoIP Monitor corresponds to per hop 
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behavior (PHB) and Differentiated Service Code Point (DSCP) values as shown 
in the following table. 

   TOS Byte (IPv4) / Traffic Class (IPv6)   

   DSCP   

   IP 
Precedence       

Flow 
Control    

  
ToS 

Value 
(decimal) 

DSCP 
Value 

(decimal) 
b7 b6 b5 b4 b3 b2 b1 b0 PHB Drop 

Probability 

Best Effort 0 0 0 0 0 0 0 0 0 0 Default   

32 8 0 0 0 0 0 0 0 0 CS1   

64 16 0 1 1 0 0 0 0 0 CS2   

96 24 0 1 0 0 0 0 0 0 CS3   

128 32 1 0 1 0 0 0 0 0 CS4   

160 40 1 0 0 0 0 0 0 0 CS5   

192 48 1 1 1 0 0 0 0 0 CS6   

Class 
Selector 

(Backward 
Compatibility 

with IP 
Precedence) 

224 56 1 1 0 0 0 0 0 0 CS7   

40 10 0 0 1 0 1 0 0 0 AF11 Low 

48 12 0 0 1 1 0 0 0 0 AF12 Medium 

56 14 0 0 1 1 1 0 0 0 AF13 High 

72 18 0 1 0 0 1 0 0 0 AF21 Low 

80 20 0 1 0 1 0 0 0 0 AF22 Medium 

88 22 0 1 0 1 1 0 0 0 AF23 High 

104 26 0 1 1 0 1 0 0 0 AF31 Low 

112 28 0 1 1 1 0 0 0 0 AF32 Medium 

120 30 0 1 1 1 1 0 0 0 AF33 High 

136 34 1 0 0 0 1 0 0 0 AF41 Low 

144 36 1 0 0 1 0 0 0 0 AF42 Medium 

Assured 
Forwarding 

152 38 1 0 0 1 1 0 0 0 AF43 High 
Expedited 
Forwarding 184 46 1 0 1 1 1 0 0 0 EF   

 

Monitoring Cisco CallManager Health 
VoIP Monitor references the Cisco Management Information Base (MIB) 
CISCO-CCM-MIB to provide out-of-the-box monitoring capability for Cisco 
CallManager and CallManager Express devices. With the use of custom MIB 
pollers, VoIP Monitor can also track the performance of call managers from other 
manufacturers. For more information about custom MIB pollers, see “Creating 
Custom MIB Pollers” in the SolarWinds Orion Network Performance Monitor 
Administrator Guide. Once a call manager device has been added to the Orion 
database for management by Orion Network Performance Monitor, you can use 
the intuitive interface of VoIP Monitor to track and report call-processing 
performance statistics for your VoIP network. 
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Only Cisco CallManager and CallManager Express devices may be added to 
VoIP Monitor as CallManager nodes. Call management devices from other 
manufacturers may be added, and monitored, as VoIP devices on the VoIP 
Infrastructure page in the VoIP Monitor Admin menu. For more information, see 
“Adding Cisco CallManager Devices to VoIP Monitor” on page 14. For more 
information about adding non-Cisco call management devices, see “Adding Call 
Manager Devices from Other Manufacturers” on page 15. 

Using VoIP Monitor in the Orion Web Console 
VoIP Monitor is a fully integrated module of the Orion NPM Web Console. Once 
VoIP Monitor is installed, click VoIP Monitor in the Orion Web Console Modules 
toolbar to open the VoIP Summary View. For more information about installing 
VoIP Monitor, see “Installing VoIP Monitor” on page 6. For more information 
about the VoIP Summary View, see “VoIP Monitor Views” on page 23. 

All VoIP network devices and relevant interfaces that you want to monitor with 
VoIP Monitor must first be managed by Orion Network Performance Monitor. For 
more information, see “Using Orion System Manager” in the SolarWinds Orion 
Network Performance Monitor Administrator Guide. After you add your VoIP 
devices and interfaces to the Orion database, you can then submit them to VoIP 
Monitor for monitoring. 

Adding VoIP Devices and Interfaces to VoIP Monitor 
VoIP-capable devices and interfaces that have been included in the Orion 
Network Performance Monitor database may be designated for monitoring by 
VoIP Monitor. The following procedure provides the steps that are required to 
add a VoIP device or interface to VoIP Monitor. 

To add a VoIP device or interface to VoIP Monitor: 

1. Log on to your Orion VoIP Monitor server. 

2. If you have not added your VoIP devices to the Orion database, use 
Orion System Manager to add your VoIP devices before you continue. For 
more information, see “Using Orion System Manager” in the SolarWinds 
Orion Network Performance Monitor Administrator Guide. 

Note: If the node that you are adding is intended be a VoIP Simulation node, 
provide an SNMP read/write community string when adding the node. 

3. Click Start > SolarWinds Orion > VoIP Monitor > VoIP Web Console. 

4. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password. 

5. Click Admin on the toolbar. 
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6. Click VoIP Monitor Settings in the left navigation pane. 

7. Click Infrastructure. 

8. Navigate the available devices and interfaces and check the appropriate 
objects for your VoIP network. 

9. If you do not see an expected VoIP-related device or interface in the list, 
use System Manager to add the device to the Orion database. For more 
information, see “Using Orion System Manager” in the SolarWinds Orion 
Network Performance Monitor Administrator Guide. 

Note: If you are adding a VoIP Simulation node, you must provide an SNMP 
read/write community string when you add the device in System Manager. 

Adding Cisco CallManager Devices to VoIP Monitor 
The following procedure provides the steps to add a Cisco CallManager device to 
VoIP Monitor. 

To add a CallManager device to VoIP Monitor: 

1. Log on to your Orion VoIP Monitor server. 

2. If you have not added your CallManager devices to the Orion database, 
use System Manager to add your CallManager devices before continuing. 
For more information on adding CallManager devices, see “Adding VoIP 
Devices and Interfaces to VoIP Monitor” on page 13. 

3. Click Start > SolarWinds Orion > VoIP Monitor >VoIP Web Console. 

4. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password.  

5. Click Admin on the toolbar. 

6. Click VoIP Monitor Settings in the left navigation pane. 

7. Click CallManager Nodes. 

8. Click Add. 

9. Select the appropriate device type: Cisco CallManager or CallManager 
Express. 

10. Expand the device lists and review available CallManager-hosting devices. 
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11. Check the devices hosting the CallManagers you want to monitor, and then 
click Add. 

Note: If you do not see an expected CallManager device in the list, you need 
to use System Manager to add the device to your Orion database. For more 
information on adding CallManager devices, see “Adding VoIP Devices and 
Interfaces to VoIP Monitor” on page 13. 

12. Check the CallManager devices you want to monitor, and then click Add. 

Deleting Cisco CallManager Devices from VoIP Monitor 
The following procedure provides the steps to delete a Cisco CallManager device 
from VoIP Monitor. 

1. Log on to your Orion VoIP Monitor server. 

2. Click Start > SolarWinds Orion > VoIP Monitor >VoIP Web Console. 

3. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password.  

4. Click Admin on the toolbar. 

5. Click VoIP Monitor Settings in the left navigation pane. 

6. Click CallManager Nodes. 

7. Select the CallManager-hosting devices you want to delete, and then click 
Delete. 

Adding Call Manager Devices from Other Manufacturers 
Call managers from manufacturers other than Cisco can be monitored with VoIP 
Monitor if you use a custom management information base (MIB) poller 
specifically configured for your non-Cisco call manager. VoIP Monitor treats 
non-Cisco call managers as nodes, so the procedure for adding them is the 
same as for any other VoIP device. For more information about creating custom 
MIB pollers, see “Creating Custom MIB Pollers” in the SolarWinds Orion Network 
Performance Monitor Administrator Guide. For more information about adding 
devices to VoIP Monitor, see “Adding VoIP Devices and Interfaces to VoIP 
Monitor” on page 13. 

Note: VoIP Monitor presents a non-Cisco call manager as another VoIP network 
node. Non-Cisco call managers are not displayed with Cisco devices in the 
CallManagers resource. 
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Configuring VoIP Monitor 
After establishing your basic VoIP Monitor configuration with the Configuration 
Wizard, you can change your settings at any time to further customize VoIP 
Monitor for your network. The following sections present configuration options 
and procedures for VoIP Monitor. 

VoIP Monitor Settings 
VoIP Monitor Settings are configured on the VoIP Monitor Settings page, 
available on the Orion Web Console Admin page. VoIP Monitor settings are also 
viewable from any page in VoIP Monitor by clicking VoIP Settings at the top 
right. The following aspects VoIP Monitor may be configured from this page: 

Settings 

Presents general options regarding your configuration of VoIP Monitor. From 
the VoIP Monitor Settings page you can configure the following aspects of 
your VoIP Monitor installation: 

• The port through which VoIP Monitor sends simulated traffic 

• The jitter codec that VoIP Monitor simulates on your network 

• The interval on which VoIP Monitor tests your network 

• The length of time that collected data is retained in the Orion database 

• The MOS advantage factor to characterize your VoIP network for the 
purpose of determining the Mean Opinion Score (MOS). 

• The Type of Service (ToS) octet allows you to set precedence levels for 
VoIP traffic and IP SLA operations. 

Thresholds 

Establishes error and warning levels for MOS, jitter, latency, and packet loss 
over your VoIP Network. Based on the values that you provide to define error 
and warning conditions, VoIP Monitor can inform you of your VoIP network 
status in the following ways: 

• Through the web console view 

• In reports that you generate with Report Writer 

• With alerts and actions that you can define using Advanced Alert 
Manager 
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Sites 

Provides an intuitive interface for defining independent locations, or sites, on 
your VoIP network. Each site on your VoIP network is associated with a 
designated simulation node. You can easily create new sites and edit 
existing locations from the VoIP Monitor Sites page. 

Note: VoIP Monitor sites are limited to locations where there is an existing, 
Cisco IP SLA-compatible router to serve as a simulation node. Cisco IP 
SLA-compatible routers include 2600, 3700, and 7200 Series. For more 
information, see www.cisco.com/go/fn and select “IP SLAs – UDP Based 
VoIP Operation”. 

Call Paths 

Allows you to define possible call routes between simulation nodes that you 
have entered on the VoIP Monitor Sites page. These are the call paths over 
which VoIP Monitor sends simulated traffic for determining the status and 
performance of your VoIP network. VoIP Monitor provides an easy-to-use 
interface that gives you the ability to quickly define these flexible call paths. 

Infrastructure 

Gives you the ability to designate nodes that are currently monitored by 
Orion Network Performance Monitor as specifically VoIP-related. VoIP 
Monitor can monitor any node that is relevant to your VoIP network, provided 
you have first added the node with System Manager. By expanding the given 
node trees, you can choose to monitor VoIP traffic down to the interface 
level. For more information about adding devices and interfaces, see “Adding 
VoIP Devices and Interfaces to VoIP Monitor” on page 13. 

CallManager Nodes 

Allows you to specify the devices on your VoIP network that are Cisco 
CallManager and CallManager Express devices. The VoIP Monitor 
CallManagers resource is specifically tailored for Cisco CallManager devices. 
You must first add CallManager nodes to your Orion database with System 
Manager before they are available for monitoring by VoIP Monitor. For more 
information about adding devices and interfaces, see “Adding VoIP Devices 
and Interfaces to VoIP Monitor” on page 13. 

Database Details 

Provides installation and memory sizing information about the database VoIP 
Monitor uses to store VoIP network data. Additionally, you can view statistics 
about individual tables within your database. Select a table from the list to 
see a count of rows and memory usage by data and indexes, respectively. 

http://www.cisco.com/go/fn
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VoIP Monitor Settings Configuration 
The following steps guide you through the process of configuring VoIP Monitor 
settings for your VoIP network. 

To configure VoIP Monitor settings: 

1. Log on to your Orion VoIP Monitor server. 

2. Click Start > SolarWinds Orion > VoIP Monitor >VoIP Web Console. 

3. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password.  

4. Click Admin on the toolbar. 

5. Click VoIP Monitor Settings in the left navigation pane. 

6. Click Settings. 

7. If you want to use a port other than the default Port number for 
simulated VoIP traffic, type your preferred port in the appropriate field. 

8. Select the Jitter codec to simulate for your VoIP network. For more 
information about jitter codecs, see “Jitter” on page 9. 

9. Type a Network test interval, in minutes. 

Notes: 

• VoIP Monitor measures the performance of your network by periodically 
sending test packets over the call paths that you have defined. The 
period between these packet transmissions is referred to as the Network 
Test Interval. For more information, see “Jitter” on page 9. 

• As network sizes and VoIP server performance vary, you may have to try 
a number of different intervals to achieve the desired balance between 
server processing load and data resolution. 

10. Type the period of time, in days, to retain VoIP data in the Call path test 
data retention field. 

Notes: 

• VoIP Monitor stores statistics regarding the performance of your VoIP 
network in your Orion database. The length of time that this data is 
retained is configurable, allowing you to balance database maintenance 
with IP SLA requirements. 

• As network sizes and VoIP server performance vary, you may have to try 
a number of different retention periods to achieve the desired balance 
between database memory allocation and data retention. 
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11. Type a value for the MOS advantage factor. 

Note: The advantage factor is a measure, on a scale of 0 to 20, of the 
willingness of your VoIP network users to trade call quality for convenience. 
For example, a cellular telephone is more convenient than a wired telephone, 
so some loss of call quality due to compression over a cellular phone, as 
compared to call quality over a wired phone, is acceptable to most users. 
This distinction is reflected in a higher advantage factor for a cellular phone 
network than for a wired phone network. For more information, see “Packet 
Loss” on page 10. 

12. Provide a value for the Type of Service (ToS) octet that sets the 
precedence for VoIP traffic. 

Note: The ToS octet is a decimal value (0-255) that sets the precedence for 
VoIP traffic monitored with Cisco IP SLA operations. The default ToS value 
used by VoIP Monitor is 184, corresponding to Expedited Forwarding (EF) 
per hop behavior (PHB) and a Differentiated Service Code Point (DSCP) 
value of 46. For more information, see “Setting VoIP Traffic Precedence” on 
page . 11 

13. Click Submit, when you have completed your configuration. 

Configuring VoIP Devices for IP SLA Operations 
Cisco IP Service Level Agreements (IP SLAs) are the primary means by which 
VoIP Monitor acquires information about the performance of your VoIP network. 
The process of configuring a device for IP SLA can be quite intricate, as it can 
involve numerous command line operations on each router. To ease the process 
of device configuration for IP SLA, VoIP Monitor uses the Round Trip Time 
Monitor (RTTMON) MIB from Cisco to configure VoIP simulation nodes. When 
you add your VoIP routers, VoIP Monitor enables them for IP SLA operations 
automatically, allowing you to start monitoring your VoIP network immediately. 

Note: VoIP Monitor automatically checks for IP SLA-compatibility when adding 
simulation nodes. It confirms that rttMonApplResponder of CISCO-RTTMON-MIB 
is “on”. To ensure that VoIP Monitor is able to configure and maintain devices for 
IP SLA operations, you must provide read-write credentials for each router you 
want to serve as a simulation node. You provide these credentials when adding 
devices with Orion System Manager. For more information about the MIBs that 
VoIP Monitor continually updates, see “MIBs Maintained by VoIP Monitor for IP 
SLAs” on page 31. 
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Selecting VoIP Sites 
After you include VoIP devices in your Orion database and VoIP Monitor 
configures them for IP SLA operations, the next step is to designate appropriate 
VoIP devices as simulation nodes. Both endpoints, or sites, on a VoIP call path 
must be associated with a simulation node. VoIP Monitor determines potential 
simulation nodes as you select them on the VoIP Infrastructure page. Simulation 
nodes must be IP SLA-compatible Cisco routers. Additionally, when you add a 
potential simulation node to Orion System Manager, you must grant Orion NPM 
write access to the router, so that VoIP Monitor can enable IP SLA operations on 
the added router. The following section details the process of both defining sites 
and designating simulation nodes. 

Note: With the exception of Catalyst 4500 series switches, all Cisco IOS 
hardware supports IP SLA operations. If a potential simulation node does not 
support Cisco IP SLA operations or Orion NPM does not have write access to the 
selected simulation node, an error message displays when you try to add the 
device as a simulation node. The selection operation will not complete. 

Designating Sites 
VoIP Monitor provides performance statistics for your VoIP network by sending 
simulated traffic over call paths between sites that you define. The following 
procedure designates sites over which VoIP Monitor monitors simulated traffic. 

To designate simulation nodes on your VoIP network: 

1. Log on to your Orion VoIP Monitor server. 

2. Click Start > SolarWinds Orion > VoIP Monitor > VoIP Web Console. 

3. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password. 

4. Click Admin on the toolbar. 

5. Click VoIP Monitor Settings in the left navigation pane. 

6. Click Sites. 

7. Click Create a new site. 

8. Complete the Name field. 

Note: The Name of a VoIP site is not necessarily the same as its network 
name or IP address. The optional site name option helps you identify the 
simulation node, for example, in terms of its geographic or physical location. 

9. Select the VoIP Simulation Node at the site you are creating, and then click 
Create. 
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Once you have established the VoIP sites in your network, you must designate 
the call paths over which you want to monitor traffic and record performance 
statistics, as shown in the following section. 

Designating Call Paths 
VoIP Monitor provides performance statistics for your VoIP network by sending 
simulated traffic over call paths between sites that you define. Because large 
VoIP networks quickly become complicated, VoIP Monitor provides an 
easy-to-use interface for establishing call paths. The VoIP Call Paths page offers 
the following three options for establishing monitoring: 

Fully Meshed 

Connects every VoIP site you define over distinct call paths to every other 
VoIP site in your network. 

Hub and Spoke 

Establishes designated VoIP sites as hubs. Each hub is then connected to all 
other VoIP sites, with call paths representing spokes. 

Custom 

Allows you to define your own call paths. All defined VoIP sites are listed. 
Expanding each site displays a list of all other VoIP sites. Checkboxes allow 
you to define call paths in whatever way best suits your requirements. 

The following procedure provides the steps that you need to designate call paths 
in VoIP Monitor. 

To designate call paths on your VoIP network: 

1. Log on to your Orion VoIP Monitor server. 

2. Click Start > SolarWinds Orion > VoIP Monitor >VoIP Web Console. 

3. Log in to VoIP Monitor using a User ID with administrative privileges. 

Note: Initially, Admin is the default administrator User ID with a blank 
Password. 

4. Click Admin on the toolbar. 

5. Click VoIP Monitor Settings in the left navigation pane. 

6. Click Call Paths. 

7. If you want to monitor all possible call paths on your VoIP network, 
select Fully Meshed. 
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8. If you want to employ a hub and spoke configuration for your call 
paths, complete the following steps: 

a. Select Hub and Spoke. 

b. Click Add, select a site to serve as a hub, and then click Submit. 

c. Repeat until you have added all the hubs you want. 

d. If you want to delete a hub, select the hub and then click Delete. 

9. If you want to configure custom call paths, select endpoints as follows: 

a. Select Custom. 

b. If you want to select all call paths originating from a specific site, 
check that site at the top level. Checking the top-level site selects all 
other endpoints on call paths from the selected site. 

c. Select additional call paths by expanding the available call path tree and 
then choosing call paths according to the following rules: 

• Top-level sites are “From” endpoints. 

• Secondary sites are “To” endpoints. 
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Chapter 3 

Using VoIP Monitor 

Orion VoIP Monitor employs the same proven Web Console architecture used by 
Orion NPM, but VoIP Monitor focuses on the VoIP-related devices of your 
Orion-managed network. VoIP Summary View provides a customizable default 
page for VoIP Monitor. This default page gives you a complete overview of your 
entire VoIP network at a glance. After you have installed VoIP Monitor, you can 
start monitoring your VoIP network from the VoIP Summary View. 

To start VoIP Monitor: 

1. Log on to your Orion VoIP Monitor server. 

2. Click Start > SolarWinds Orion > VoIP Monitor > VoIP Web Console. 

Note: You can also open VoIP Monitor at any time from within the Orion Web 
Console by clicking VoIP Monitor in the toolbar. 

VoIP Monitor Views 
VoIP Monitor presents current metrics of VoIP network performance in easily 
reviewed tables, graphs, and charts. The following sections detail the statistics 
that are available in views of each aspect of your VoIP network. For more 
information about customizing VoIP Monitor views, see “Customizing Views” in 
the SolarWinds Orion Network Performance Monitor Administrator Guide. The 
following views are provided with VoIP Monitor: 

VoIP Summary View 

Provides an overview of your entire VoIP network, including resources that 
present information about VoIP devices, VoIP-related events and alerts, call 
paths, and overall performance metrics. 

VoIP CallManager View 

Provides in-depth information about individual Cisco CallManager devices, 
including registered and unregistered phone statistics and device properties. 

VoIP Call Path View 

Provides performance statistics, gauges, and charts for individual call paths. 

VoIP Site View 

Provides performance statistics, gauges, and charts for individual VoIP sites. 
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Using Advanced Alerts and Actions 
VoIP Monitor provides a number of VoIP-specific alerts you can use with Orion 
Advanced Alert Manager to actively monitor and respond to detected issues. The 
Orion Advanced Alerts Manager also allows you to designate actions for VoIP 
Monitor alerts. 

Note: Only advanced alerts may be used for VoIP-specific purposes. Basic alerts 
can not be configured to trigger on VoIP conditions or events. 

VoIP Monitor Alerts 
Your installation of VoIP Monitor supplements the alerting abilities of Orion 
Network Performance Monitor with a number of VoIP-specific alerts. 

Alert Condition 

Jitter Triggered whenever a threshold value for latency variability is either met 
or sustained for a designated period of time. 

Latency 
Triggered whenever the measured delay on a designated call path 
reaches a threshold value, or it can be triggered if a defined delay is 
sustained for a designated period of time. 

Mean Opinion 
Score (MOS) 

Triggered whenever a connection either experiences a MOS below a 
specified level or maintains a specified MOS over a set period of time. 

Packet Loss Triggered whenever perceived packet loss either exceeds a threshold 
value or is sustained at a designated level for a specified period of time. 

VoIP 
Infrastructure 
Node Status 

Triggered whenever a designated node changes status, Up or Down. 

 

Other alerts can be configured following the procedures in the SolarWinds Orion 
Network Performance Monitor Administrator Guide and using variables available 
in Orion NPM and the Advanced Alert Manager. For more information about 
using Advanced Alerts within Orion Network Performance Monitor, see “Creating 
and Configuring Advanced Alerts” in the SolarWinds Orion Network Performance 
Monitor Administrator Guide. 

Creating VoIP Monitor Reports 
Because VoIP Monitor is an integrated module of Orion Network Performance 
Monitor, information that you collect about your VoIP network is easily presented 
in a variety of formats using Orion Report Writer. SolarWinds provides Report 
Writer as a quick and easy way for you to extract data from your database, 
including VoIP network statistics, for presentation in a useful form. A number of 
predefined VoIP-specific reports are available with your installation of VoIP 
Monitor. Report Writer also enables custom VoIP report creation, as necessary, 
using criteria and conditions you choose. When you have finished editing your 
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reports, you can view them through the VoIP Monitor web interface and print 
them with the click of a button. 

A report scheduling application is available to all customers with a current 
maintenance agreement. This tool schedules automatic email reports that can be 
sent to individual users or groups of users. Simply log in to the customer portal of 
www.solarwinds.com and download the Report Scheduler. 

Report Writer capabilities are further enhanced when they are used in 
conjunction with the Custom Property Editor. Custom properties are available for 
report sorting and filtering. For more information about using custom properties, 
see “Creating Custom Properties for VoIP Monitor” on page 25. 

Using Predefined VoIP Reports 
A number of VoIP-specific reports have been provided with your installation of 
VoIP Monitor. The following reports are provided through Orion Report Writer: 

• Calls from a Site over the Last XX Days 

• Calls to a Site over the Last XX Days 

• Delay over the Last XX Days 

• Jitter over the Last XX Days 

• MOS over the Last XX Days 

• Packet Loss % over the Last XX Days 

• VoIP Infrastructure Availability 

Other reports may be generated using variables available in Orion Report Writer. 
For more information about using Report Writer within Orion Network 
Performance Monitor, see “Creating Reports” in the SolarWinds Orion Network 
Performance Monitor Administrator Guide. 

Creating Custom Properties for VoIP Monitor 
Orion Custom Property Editor is available to simplify the task of monitoring your 
VoIP network. The Custom Property Editor allows you to define custom 
properties, such as country, building, asset tag, and serial number. These 
properties may apply to any VoIP device or interface that you have stored in the 
VoIP Monitor database. Once properties are added, they are available for display 
and filtering within any Orion application. A few examples of how custom 
properties may be used are as follows: 

• Add a custom property and display it as an annotation on a chart. 

• Add a custom property to interfaces to display a custom description. 
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• Add a custom property that is used as an account limitation on sites. 

• Add additional information to sites, such as contact, owner, or support 
contract number. 

• Add a notification property to sites that can configure the alerts feature to 
send an email to a computer named within the custom property. 

• Add a custom property to routers and interfaces for grouping them on the 
web or in a report. 

• Add a custom property of billing codes or customer IDs. 

Custom Property Editor allows you to choose from a collection of commonly used 
properties, or you can easily and efficiently build your own custom properties. 
Once your custom property is defined, the Import Wizard allows you to populate 
your new property from either a text- or comma-delimited file. For more 
information about creating custom properties for VoIP Monitor, see “Creating 
Custom Properties” in the SolarWinds Orion Network Performance Monitor 
Administrator Guide. 

Customizing Charts in VoIP Monitor 
You can easily customize charts produced within the Orion Network Performance 
Monitor Web Console are easily customizable. The following sections describe 
options that are available on the Customize Chart page to modify the 
presentation of a selected chart. 

Note: Click Refresh at any time while customizing a chart to review changes you 
have made. 

Chart Titles 
Chart Titles are displayed at the top center of a generated chart. The Chart 
Titles area allows you to modify the title and subtitles of your generated chart. 

Note: Orion Network Performance Monitor may provide default chart titles and 
subtitles. If you edit any of the Chart Titles fields on the Custom Chart page, you 
can restore the default titles and subtitles by clearing the respective fields, and 
then clicking Submit. 
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Time Periods 
You can designate a predefined or custom time period for your chart using either 
of the following methods: 

• Select a predefined time period from the Adjust Time Period for Chart menu. 

• Provide custom Beginning and Ending Dates/Times in the appropriate fields 
in the Enter Date / Time Period area. 

Adjust Sample Interval 
The sample interval dictates the precision of your generated chart. A single point 
or bar is plotted for each sample interval. If a sample interval spans multiple 
polls, polled data is automatically summarized and plotted as a single point or bar 
on the chart. 

Note: Due to limits of memory allocation, some combinations of time periods and 
sample intervals may require too many system resources to display, due to the 
large number of polled data points. As a result, charts may not display if the time 
period is too long or if the sample interval is too small. 

Chart Size 
Chart size options configure the width and height, in pixels, of the chart. You can 
maintain the same width/height aspect ratio, or scale the chart in size, by 
entering a width in the Width field and then entering 0 for the Height. 

Data Tables 
The Data Table Below Chart option displays a table of the charted data points 
below the chart. 

Note: You may not be able to read individual data points if you select a small 
sample interval. Select a larger sample interval to make it easier to read data 
points. 

Font Size 
Font sizes for generated charts are variable. The Font Size option allows you to 
select a Small, Medium, or Large size font for your chart labels and text.  

Note: Font size selections are maintained in the printable version of your chart. 

Printing Options 
To print your customized chart, click Printable Version. A printable version of 
your customized chart displays in the browser. 
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Data Export Options 
Exportable chart data is also available in the Display Data from Chart area as 
Microsoft Excel-compatible Raw Data or as HTML-formatted Chart Data, as 
shown in the following steps. 

To export chart data: 

1. If you want to view your chart data as Microsoft Excel-compatible 
Raw Data, click Raw Data in the Display Data from Chart area, and then 
follow the prompts, if provided, to open or save the resulting raw data file. 

2. If you want to view your chart as HTML-formatted data, click Chart Data 
in the Display Data from Chart area and the data for your chart displays in a 
new browser window. 
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Appendix A 

Software License Key 

During installation, you may be prompted with the Install Software License Key 
window requesting that you supply your name, e-mail address, phone number, 
customer ID, and password. If this is the case, follow the instructions below to 
enable a software license key. 

To enable a software license key: 

1. If the computer on which you are installing Orion VoIP Monitor is 
connected to the Internet and not behind a proxy server, enter the 
requested information on the Install Software License Key window, and then 
click Continue. 

Note: The SolarWinds license registration server will immediately issue a 
license key that will allow VoIP Monitor to operate. 

2. If the computer on which you are installing Orion VoIP Monitor is not 
connected to the Internet, your server cannot authenticate to the 
SolarWinds license registration server, so you must complete the following 
procedure. 

a. Click Skip This and Enter Software License Key Now on the Install 
Software License Key window. 

b. Using another computer that is connected to the Internet, log in to the 
customer area of the SolarWinds website at www.solarwinds.com/keys. 

c. Click Software Keys from the Customer Area menu. 

d. Select the product for which you need a key, and follow the instructions 
on the page to obtain a key. 

e. Enter the key in the Enter Software License Key text box. 

3. Click Continue to complete your Software License Key installation. 
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Appendix B 

MIBs Maintained by VoIP Monitor for IP SLAs 

VoIP Monitor continually updates CISCO-RTTMON-MIB in order to maintain IP 
SLA operations between VoIP devices. The following MIB names are maintained 
by VoIP Monitor, according to the settings of your VoIP Monitor implementation, 
as it conducts IP SLA operations: 

• rttMonCtrlAdminRttType. 

• rttMonEchoAdminProtocol 

• rttMonEchoAdminTargetAddress. 

• rttMonEchoAdminSourceAddress 

• rttMonEchoAdminTargetPort 

• rttMonCtrlAdminFrequency 

• rttMonEchoAdminCodecType 

• rttMonEchoAdminCodecPayload 

• rttMonEchoAdminCodecNumPackets 

• rttMonEchoAdminCodecInterval 

• rttMonEchoAdminICPIFAdvFactor 

• rttMonCtrlAdminStatus 

• rttMonScheduleAdminRttLife 

• rttMonEchoAdminTOS 

• rttMonScheduleAdminRttStartTime 
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Appendix C 

Bandwidth Gauges 

Bandwidth Gauges provides realtime traffic monitoring. A bandwidth gauge can 
be configured to monitor the transmit and receive utilization of any remote 
network device, using SNMP to communicate and gather traffic statistics. 
Gauges display transmit and receive traffic in bits per second or transmit and 
receive percent utilization for each interface or port. 

Bandwidth Gauges Menus 
The following menus present options that are available for configuring bandwidth 
gauges. 

File Menu 
The following options for bandwidth gauges are available from the File menu. 

Load Gauges 

Loads a set of gauges from a previously save file. This file has the extension 
.BandwidthGauges, and it is created by clicking File > Save or File > Save 
As. 

Save 

Saves the current set of gauges as a *.BandwidthGauges file. This file can 
be reloaded later by selecting File > Load Gauges. 

Save As 

Saves the current set of gauges as a *.BandwidthGauges file with a new 
filename. This file can be reloaded later by selecting File > Load Gauges. 

Close 

Closes all gauges currently displayed. 

Publish to Web 

Saves the gauges as an HTML file and saves gauge images to the specified 
location. This location could be part of a web site.  

New Window 

Opens another instance of the Bandwidth Gauges in a new window. 
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Settings 

Opens the Settings dialog window. 

Exit 

Exits the program. You should save your gauges before exiting if you want to 
reload them without having to add them one at a time. 

Gauges Menu 
The following options for bandwidth gauges are available from the Gauges menu. 

New Gauge 

Adds a new gauge to the list. 

Refresh 

Polls all devices and the updates the associated gauges. Some devices, 
including Windows servers, update the traffic statistics in their SNMP Agent 
every 15 to 20 seconds. If the device is polled more frequently than the 
remote SNMP Agent is updated, the gauges may show 0 bps, and then show 
the correct values a few seconds later. If you notice the gauges changing 
from 0 bps to a higher value, you may need to increase the poll interval. 
Double-click on a gauge to adjust its poll interval. 

Modifying Settings and the Publishing of Gauges 
The following sections detail options for publishing bandwidth gauges. These 
settings tabs are available by clicking File > Settings. 

Layout Tab 
The following options for bandwidth gauges are available on the Layout tab. 

Number of Columns 

Sets the maximum number of gauges to be displayed in each row. When a 
new gauge is added, a new row will be created if the current row is already 
displaying the maximum number of gauges. 

Reposition Gauges 

Use the up and down arrows to arrange the display order of the gauges. 
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Transparency Tab 
The following options for bandwidth gauges are available on the Transparency 
tab. 

Switch to transparent mode after a few seconds 

When this option is enabled, moving the mouse cursor away from the 
Bandwidth Gauges window will activate the transparent mode. When the 
gauges are transparent, mouse clicks will be passed to the workspace 
(applications running behind the gauges) instead of to the gauges. To exit 
transparent mode, place the mouse cursor over the Bandwidth Gauges title 
bar. 

Transparent Slider 

Adjust the slider to change the transparency opacity. To make the gauges 
more prominent, increase the percentage, decrease it to make the gauges 
more transparent. 

Keep Bandwidth Gauges on top of other windows 

Check this option to show Bandwidth Gauges on top of all windows even 
when working in another application. 

Note: When Switch to transparent mode after a few seconds is enabled, the 
Bandwidth Gauges will always be placed on top of other windows. 

Gauge Styles Tab 
The Gauge Styles tab provides a number of design options for viewing your 
bandwidth gauges. 

Style of Gauge 

There are over thirty different gauge styles to choose from. Changing the 
Style in the Bandwidth Gauges Settings dialog only changes the default 
style. Click Apply to All to change the current gauges to the selected style.  

Double-click on a gauge to modify the settings for a single set of gauges. 
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Data Table Tab 
The Data Table tab provides the option of displaying a data table below your 
bandwidth gauges. 

Show a data table below Gauges 

Check this to set the default data table for all gauges. When a new gauge is 
added, it will contain a data table with the Selected Statistics shown here. 
Click Apply to All to add a data table to the gauges currently displayed. 

Double-click on a gauge to modify the settings for a single set of gauges. 

Network Tab 
The sliders on the Network tab are used to adjust polling frequency, timeout, and 
the frequency with which gauges are displayed. Clicking Apply to All applies the 
Update Gauges every XX seconds value to all gauges currently displayed. 

Note: Some devices, including Windows servers, only update the traffic statistics 
in their SNMP Agent every 15 or 20 seconds. If the device is polled more 
frequently than the remote SNMP Agent is updated, the gauges may show 0 bps, 
and then show the correct values a few seconds later. If you notice the gauges 
changing from 0 bps to a higher value, you may need to increase the poll 
interval. Double-click on a gauge to adjust its poll interval. 

Auto-Publish 
Bandwidth gauges may be formatted to publish directly to the web, by selecting 
the following option on the Auto-Publish tab. 

Auto-Publish these Gauges to a Web 

When this is selected, an HTML file will be created every few seconds. The 
Web Page Title will be displayed on the title bar of the web browser and as 
the title of the web page. Adjust the slider at the bottom of the window to 
change how often the HTML file is updated. 

Context Menus 
Right-click on any gauge to display a context menu of further options for the 
selected gauge. 

Copy 

Right-clicking on a gauge and selecting Copy will copy an image of that 
gauge to the clipboard. Alternately, when right-clicking on the data table and 
selecting Copy will copy the data table text to the clipboard. 



SolarWinds Orion VoIP Monitor  Administrator Guide 
 

 
Bandwidth Gauges  37 

Delete Selected Gauge 

Deletes the gauge from the current display. 

New Gauge 

Opens the New Traffic Gauges dialog to add a new gauge to the current 
display. 

Reset 

Clears the historical statistics and starts a new baseline for the selected 
gauge. 

Refresh 

Polls the selected device and the updates the gauges. Some devices, 
including Windows servers, only update their MIBs every 15 or 20 seconds. If 
the device is polled more frequently than the MIB is updated, zero values will 
be reported. 

Data Table 

Displays the data table if not currently shown. If a data table is already 
displayed, it will be removed.  

Historical Chart 

Displays a brief history of the selected gauge in a chart format. 

Historical Statistics 

Displays a brief history of the selected gauge in a table format. 

Properties 

Opens the Gauge Properties dialog for the selected gauge. 

Note: Any value adjusted in this dialog will only apply to the selected gauge. 
To change values for all gauges, use the Bandwidth Gauges Settings dialog. 

Saving and Loading a Set of Gauges 
Once you have a set of gauges defined, you can save their configuration as a file 
that can be loaded at anytime.  

To save a set of gauges: 

1. Click File > Save Gauges. 

2. Specify a name for the configuration file, and then click Save. 
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To reload a set of gauges: 

1. Click File > Load Gauges. 

2. Navigate to the configuration file, and then click Open. 
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L 
lag See latency 
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